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Project Overview 
 

Introduction to Introduction to PowerPoint 

 

In this project, teachers are introduced to the program Microsoft 

PowerPoint by creating a multimedia presentation for a School Open 

House. The sample presentation informs parents about the curriculum, 

classroom procedures, and school events. To produce this slide show, 

educators learn how to insert slides and format their appearance. Skills 

learned in this project include: how to add text, pictures, and clip art, as 

well as how to make a table and an organizer. Once the slides are 

complete, animation and transitions are applied. With everything 

finished, the presentation is prepared for viewing in a variety of forms 

including a slide show, kiosk, video, and handout. 

 

Educators complete the following tasks: 

 

 In session 1, educators prepare to create a presentation for a school open 

house. To start, they learn about presentation software and the tasks that it 

can perform. Afterwards, educators open Microsoft PowerPoint, the program 

they will be using to create their presentation, and label the window. Next, 

they view a sample presentation to gain an understanding of the content of 

the slide show, as well as the program features available within PowerPoint. 

With educators inspired, they now use a planning sheet to organize the 

information to include in their own presentation for parents and students. 

 In session 2, educators use Microsoft PowerPoint to begin construction of their 

presentation for a school open house. The focus is upon basic technology 

skills to create simple slides. To start, students create a title slide and apply a 

design to improve the appearance. Next, they produce a slide that includes 

personal information that is organized into a customized text box with well-

formatted text. Students then apply those skills to create a slide about school 

events that includes clip art. At the end of the session, students should have a 

basic understanding of how to use PowerPoint slides to communicate 

information. 

 In session 3, educators continue to use Microsoft PowerPoint to construct their 

presentation for a school open house. The focus is upon using slide layouts 

that require advanced technology skills. To start, students create a curriculum 

slide that organizes information in a table. Next, they produce a slide that 

contains a graphic organizer used to summarize extracurricular activities. 

Students then apply their skills to create a slide that has contact information, 

as well as a hyperlink to the school website. At the end of the session, students 

should have a solid understanding of how to use PowerPoint slides to organize 

information effectively. 

 In session 4, educators bring their PowerPoint presentation to life. They learn 

how to add Custom Animation to a presentation to add interest and highlight 

the important points. Transitions are added to the slides, allowing educators to 

customize the way that the slides move in and out of view. In this session, the 

presentation becomes more exciting and polished as educators add finishing 

touches. 
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 In session 5, educators learn how to prepare the slide show so it is ready to be 

presented. The presentation is fine tuned by using the Spell Check features in 

Microsoft PowerPoint. Headers and footers are added to customize the 

presentation. The order of slides is changed to improve the flow, and slides 

are hidden or deleted if necessary, to condense the presentation. Finally, 

information is added to the notes pane to create speaker notes for the 

presenter. 

 In session 6, educators are introduced to the various ways in which they can 

share their presentations. Educators learn how to present the slide show using 

a pen, set the file to play automatically as a kiosk, save it as a video, and print 

it as a handout. Educators consider the advantages of each of these formats, 

and decide which best suits their purpose. 

 

 



 

 

 

SESSION 1 
Microsoft PowerPoint Basics 
In this session, educators prepare to create a presentation for a school open 

house. To start, they learn about presentation software and the tasks that it 

can perform. Afterwards, educators open Microsoft PowerPoint, the program 

they will be using to create their presentation, and label the window. Next, 

they view a sample presentation to gain an understanding of the content of 

the slide show, as well as the program features available within PowerPoint. 

With educators inspired, they now use a planning sheet to organize the 

information to include in their own presentation for parents and students. 

 

Assignment 1: What is Presentation Software? 

Assignment 2: Introduction to PowerPoint 

Assignment 3: View an Open House Presentation 

Assignment 4: Plan your Presentation 

Make the Connection: Customize the Content of your Presentation 
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Session 1: Microsoft PowerPoint Basics 

Getting Started 

Overview 

In this session, educators prepare to create a presentation for a school open house. To start, they 

learn about presentation software and the tasks that it can perform. Afterwards, educators open 

Microsoft PowerPoint, the program they will be using to create their presentation, and label the 

window. Next, they view a sample presentation to gain an understanding of the content of the 

slide show, as well as the program features available within PowerPoint. With educators inspired, 

they now use a planning sheet to organize the information to include in their own presentation 

for parents and students. 

 

Materials 

 Microsoft PowerPoint 

 Microsoft PowerPoint Flashcards (Optional) 

o Home tab 

o Insert tab 

o Review tab 

o View tab 

 Open House Sample Presentation – Welcome to Grade 4 

 Digital Camera (Optional) 

 

Teacher Preparation  

 Provide access to the sample presentation. 

 Prepare the flashcards. (Optional) 

 In Session 2, educators follow instructions to insert a digital photograph onto a slide. If you 

have a digital camera, take pictures of the educators. Make them available to 

educators for the following class. (Optional) 

 

Teaching Strategy 

In this project, educators learn how to use Microsoft PowerPoint by creating a presentation for a 

school open house. Explain scenario to educators: 

 

In many communities, parents visit the school to meet the teacher, 

learn more about the program, and become involved in their 

children’s learning. A great way to share information about the 

exciting things happening in the classroom is by making a slide 

show. In this project, you learn how to use the program Microsoft 

PowerPoint to create a presentation for a school open house. 

Throughout the activities are suggestions for how PowerPoint can be 

integrated into curriculum. 
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In this session, educators are introduced to Microsoft PowerPoint and the task of creating a 

presentation for a school open house. Explain scenario to educators: 

 

In this session, you prepare to create a presentation for an open house that 

communicates information to students and parents. To start, you learn about the 

program, Microsoft PowerPoint. Afterwards, you view a sample presentation to gain an 

understanding of the content. Once you have some ideas, you will plan your own 

presentation with the help of an organizer. 

 

Assignment 1 What is Presentation Software? 

 

In this assignment, educators learn about presentation software and the tasks it can perform. 

Encourage educators to compare Microsoft PowerPoint to traditional methods of 

communicating information by identifying the similarities and differences. 

 

Assignment 2 Introduction to PowerPoint 

 

In this assignment, educators are introduced to the Microsoft PowerPoint environment. They are 

asked to read a description of each part of the application window and then label a diagram. 

Encourage educators to click around in the program to discover the function of each part.  

 

Next, educators explore the ribbon. This is a great way to learn about the location of commonly 

used commands. One suggestion is to turn the activity into a scavenger hunt. You can give 

"clues" and then have educators highlight the tab, group, or command with their mouse pointer. 

 

Terminology 

 

Introduce the following terminology: 

 

views: A bar at the bottom right of the PowerPoint window that is used to switch 

between Normal view, Slide Sorter view, and Slide Show view. 

file tab: A tab on the left side of the ribbon, which opens a menu of basic commands 

used in many Microsoft Office programs, such as Save, Open, New, and Print. 

quick access toolbar: A customizable toolbar found above the ribbon that holds 

commands which are used often. 

zoom slider: A slider on the status bar that changes the magnification level of the slide in 

the window. 

slide pane: A pane in the middle of the screen used to display the current slide. 

notes pane: A pane at the bottom of the window used to add speaker notes. 

slides tab: A pane at the left side of the window used to display thumbnails of all the 

slides in the presentation. When the outline tab is selected, only the text on the slides is 

shown. 

window controls: A set of three controls at the top right corner of a program window 

used to minimize, maximize/restore, or close the program window 

ribbon: A band that contains a set of tabs including Home, Insert, Design, Transitions, 

Animations, Slide Show, Review, View and Add-Ins. 

tab: A collection of commands organized into groups, located on the ribbon. 

group: A collection of commands on a tab that do similar actions. 

command: A button, box, or menu that tells the computer what to do.  
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Assignment 3 View an Open House Presentation 

 

In this assignment, educators critically examine the content of a sample presentation titled, 

Welcome to Grade 4. This presentation includes ten slides that include information about the 

school, classroom, and program. It offers a solid overview to students and their parents about 

the things they will be doing during the school year. This presentation demonstrates the range of 

content that can be organized onto slides, as well as the various slide layouts. Educators will be 

producing a similar type of slide show in the upcoming sessions. 

 

 

 

Assignment 4 Plan your Presentation 

 

In this assignment, educators create a storyboard for their presentation. They outline the content 

for each slide in the presentation. The more detail that is added to the storyboard, the more 

direction educators will have when they begin to build the presentation. 

 

Educators should design a presentation that is applicable to their role. If the classroom teacher 

open house scenario does not apply, choose a more relevant topic. Some suggestions are: 

 administrator’s presentation to a Home and School meeting or staff meeting 

 special education teacher’s presentation to school staff 

 school librarian’s presentation to explain new procedures in the library 

 board consultant’s professional development workshop for teachers 

 course overview for students presented on the first day of class 

 project overview, describing required elements, due date, and marking scheme 

 how-to slide show, showing students the steps in Math problem solving, the story writing 

process, study skills, personal time organizer, or any topic that pertains to your class 
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Lesson Plan 

Assignment 1 - What is Presentation Software? 

 Read information about presentation software. 

 Examine a list of tasks that Microsoft PowerPoint can complete. 

 Compare traditional methods of communicating information to presentation software. 

 Consider benefits and drawbacks to using presentation software. 

 

 

Assignment 2 - Introduction to Microsoft PowerPoint 

 Open Microsoft PowerPoint. 

 Label the parts of the PowerPoint window. 

 Label the parts of the ribbon and answer questions. 

 Answer questions about the zoom slider. 

 Exit Microsoft PowerPoint. 

 

Assignment 3 - View an Open House Presentation 

 View the presentation Welcome to Grade 4.  

 Critically examine the presentation and answer questions about the content. 

 Exit Microsoft PowerPoint. 

 

Assignment 4 - Plan your Presentation 

 Reflect upon the content of the presentation. 

 Organize ideas into a storyboard. 

 

Learning Objectives 

Below is a list of the learning objectives for this session. Educators should independently be able 

to complete each task. 

 

Content Knowledge: 

 recognize the purpose of presentation software 

 compare presentation software to traditional methods of sharing information 

 plan the content of a presentation using an organizer 

 

Technical Skills: 

 

Operating Environment 

 open and close a program 

 

Presentation Skills 

 label the parts of the Microsoft PowerPoint window 

 play a slide show 

 

Applied Technology 

 critically examine the content of a slide show 
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Assignment 1: What is Presentation Software? 
 

What is Presentation Software? 

Microsoft PowerPoint is a form of presentation software. It 

can be used to present a formal display of information 

organized onto slides. A digital presentation is a useful 

method to show or explain a concept to an audience.  
 

A PowerPoint presentation can be shared in a variety of 

ways. For example, the slides can act as a visual aid 

during a lecture or speech. As well, the slide show can be 

viewed as a kiosk with the presentation playing 

automatically. In addition, the file can be posted to the 

Internet as a website, or distributed on paper as a handout. 
 

What can Teachers do with Presentation Software? 

You can complete the following tasks using Microsoft PowerPoint: 
 

 Create slides to display information. 

A slide can contain text, pictures, shapes, sound, and video. As well, a range of slide 

layouts let you easily create visual organizers and produce charts.  

 Enter and edit data easily. 

Information is entered into text boxes. Word processing features such as spell check or 

find/replace make editing easy. 

 Change the appearance of information. 

Slides can have preset designs that make them look very attractive. Moreover, text can 

be formatted to look appealing using different fonts, styles, and colors. 

 Organize and arrange information. 

It is easy to change how information is displayed. The slide layout can be edited to 

rearrange the content of a slide. Moreover, information can be deleted, copied, or 

moved to another slide. Slide order can also be easily changed. 

 Incorporate information from other sources. 

Data from Microsoft Excel, Microsoft Access, and Microsoft Word can be imported onto 

slides. In addition, hyperlinks to files or websites can be added. 

 Show a presentation on any computer. 

Microsoft PowerPoint can be saved as a video or packaged for CD. These features allow 

any computer to show a presentation without needing the software to view the file.  

 Change the type of output. 

A presentation can be viewed as a slide show or set to play automatically at a kiosk. 

Moreover, slides can be outputted as a handout, PDF file, or email.  

 Make the presentation interactive. 

Buttons, hyperlinks, and on-screen navigation tools can be used to encourage the 

audience to interact with the presentation. This enables the viewer to select the slide to 

display, a file to review, or a website to see. With a Windows Live ID, the presentation can 

be saved to your account using SkyDrive. The slide show can also be broadcast to 

remote viewers and watched in a web browser using a link created by PowerPoint. 

 Create speaker notes. 

For each slide, reference notes that highlight key points can be created. The speaker 

can then print these notes to refer to when making the presentation. 

S
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Traditional Alternatives to PowerPoint 

Educators can use Microsoft PowerPoint as an effective and engaging alternative to the 

following traditional ways of presenting information: 

 

 
Blackboards 

 
Chart Paper 

 
Books 

   

 
Overhead Projector 

 
Bulletin Board 

 
Maps 

 

Advantages and Disadvantages to Using Presentation Software 

Consider the benefits and drawbacks to using presentation software in your practice. 

 

Advantages Disadvantages 

 

 Attract and hold audience attention 

 

 Presents information in many formats 

(auditory, graphic, text) 

 

 Content is easy to edit 

 

 Layout can be rearranged 

 

 Multiple forms of output from same file 

(slide show, video, handout) 

 

 Presentation can be shown on any 

computer 

 

 Multiple sources of data, including 

Excel and Word files, can be 

incorporated 

 

 Interactive format actively involves the 

viewer 

 

 Creates speaker notes 

 

 Supports more than one learning style 

 

 A computer may not be available 

 

 Computers and software are expensive 

 

 Technology can be unreliable 

 

 The “look” of a presentation may 

overcome the message 

 

 Too much time and effort may be 

spent on the “look” of the presentation S
A
M

P
LE



INTRODUCTION TO POWERPOINT  SESSION 1 

 

TECHNOKIDS INC.  1-7 

Assignment 2: Introduction to Microsoft PowerPoint 
 

 

In this project, you will be using Microsoft PowerPoint to create  

a school open house presentation. Answer the questions to  

learn more about the program. 

 

 

 

 

Open PowerPoint and Label the Parts of the Window 

 From the START menu, select All Programs – Microsoft Office PowerPoint. 

 

 

 
 

Use the descriptions on the next page to label the parts of the window below. 

1. File Tab  4. Window Controls  7. Views 

2. Quick Access Toolbar  5. Slides Tab  8. Zoom Slider 

3. Ribbon  6. Notes Pane  9. Slide Pane 

 

 

5 

9 

6 

1 

2 4 3 

7 8 S
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Window Part Description 

views A bar at the bottom right of the PowerPoint window that is used to 

switch between Normal view, Slide Sorter view, and Slide Show view. 

file tab  A tab on the left side of the ribbon, which opens a menu of basic 

commands used in many Microsoft Office programs, such as Save, 

Open, New, and Print. 

quick access toolbar A customizable toolbar, found above the ribbon, which holds 

commands that are used often. 

ribbon A band that contains a set of tabs including Home, Insert, Design, 

Transitions, Animations, Slide Show, Review, and View.  

zoom slider A slider on the status bar that changes the magnification level of the 

slide in the window. 

slides pane A pane in the middle of the screen used to display the current slide. 

notes pane A pane at the bottom of the window used to add speaker notes.  

slides tab A pane at the left side of the window used to display thumbnails of all 

the slides in the presentation. When the outline tab is selected, only the 

text on the slides is shown. 

window controls A set of three controls at the top right corner of a program window 

used to minimize, maximize/restore, or close the program window. 
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A Closer Look at the Ribbon 

 
 

 
 

 

 

10. The ribbon has tabs. Each tab holds commands that do a similar job.  

Draw a box around the Home tab. 

  

11. Each tab is divided into groups. A group is a collection of commands that do similar 

actions like insert, delete, or change the layout of a slide. Draw a box around the Slides 

group. 

  

12. Each group has commands. Commands are a button, box, or menu that tells the 

computer what to do. Draw a box around the Paste command in the Clipboard group. 

 

 

Questions About the Ribbon 

13. Look at the Home tab. In which group of commands can you change the format of text, 

such as selecting font, size, bold, italic or underline styles? 

 Font group 

 

 

14. Look at the Home tab. What group has the command Layout? 
 

 Slides group 

 

 

15. If you want to add an object such as a picture, clip art, shape, or header and footer, 

which tab of the ribbon should you choose? 

 Insert tab 

 

 

16. What tab would you select to find transitions? 
 

 Transitions 

 

 

17. Which tab would you select to find the Spelling command? 
 

 Review tab 

 

The Ribbon is a band with a set of tabs. There are three 

parts to the Ribbon. Have a closer look. 

Group Command 

Tab 

S
A
M

P
LE



INTRODUCTION TO POWERPOINT 

 

1-10  TECHNOKIDS INC. 

Change the Zoom Level 

 

 

 

 

18. Drag the Zoom slider to the left. Now drag the Zoom slider to the right. 

 What happens when the Zoom slider is dragged to the right? 

 The slide looks bigger and the Zoom level number gets bigger. 

 

19. Click Zoom in . Now click Zoom out .  

 What happens when the Zoom out button is clicked? 

 The slide looks smaller and the Zoom level number gets smaller. 

 

20. Click on the Zoom level. 

 

 
 

 

Click to select Fit from the Zoom options. Click OK. 

 

 

 What happens when the Fit button is clicked? 

 The whole slide fits on the screen. 

 

 

Exit Microsoft PowerPoint 

 Click the File tab. Click Exit.  

The Zoom level lets you get a better look at your slide on the screen.  

Zoom in Zoom out 

Zoom level 

Zoom 

Zoom level 
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Assignment 3: View an Open House Presentation 
 

 

 

Open Sample Presentation 

 Open the Introduction to PowerPoint folder. 

 Double click Welcome to Grade 4. 

 

 

View the Sample Presentation in Slide Show View 

 Click the Slide Show button at the bottom of the screen  

or click the Slide Show tab and select Slide Show From Beginning.  

 Click to advance to each slide.  

 

 
Title Slide Curriculum Table Bulleted List of Trips 

Venn Diagram of 

Responsibilities 
Homework Policy 

 

 
Target Diagram of 

Reading Goals 

Radial Diagram of 

Extra Activities 

Organizational Chart 

of Sports 

Information About 

Parent Council 
Contact Information 

  

An open house is a special occasion where parents visit the 

school to meet the teacher, see the facilities, and learn 

more about the learning opportunities their children will 

have during the year. You are going to make a presentation 

for an open house.  

 

Watch the Open House presentation to get ideas. The 

sample presentation includes a wide range of  

program features available in Microsoft PowerPoint.  

For this reason, pay special attention to not only the  

content, but the layout, design, and special effects.  

S
A
M

P
LE



INTRODUCTION TO POWERPOINT 

 

1-12  TECHNOKIDS INC. 

Questions about the Sample Open House Presentation 

 

1. What information is included in the Open House presentation for parents? 

 Teacher and school contact information, curriculum areas and topics, trips,  

 school/student/parent areas of responsibility, homework policy, reading guidelines, 

 extracurricular activities, home and school information. 

 

 

 

2. How is the information presented? 

 Text is in bulleted point form; charts, tables, and visual organizers show information; and  

 clip art and photos add interest and appeal. 

 

 

 

3. What do you like about the presentation? 

  

  

 

 

 

4. What would you need to modify to create a presentation for parents attending your 

school Open House? 

  

  

 

 

 

5. Why do you think using presentation software is a good way to convey information to 

parents? 

  

  

 

 

Close Microsoft PowerPoint 

 Click the Close button to exit the program.  
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Assignment 4: Plan Your Presentation 
 

In this assignment, you begin to plan for your presentation. 

Your presentation will include the following slides: 

 Welcome Slide: Slide contains a title and subtitle. 

 All About Me Slide: Slide describes information about 

the teacher in a bulleted list, accompanied by a 

digital photograph. 

 Field Trips: Slide lists school outings, accompanied by 

a suitable clip art. 

 Curriculum: Slide outlines in a table the subject areas studied. 

 Student Involvement: Slide tells about school activities and clubs using a radial organizer. 

 Contact Information: Slide contains contact name and hyperlink to school website. 

 

 

Looking Ahead to Your Presentation 

After viewing the sample file, you are now aware of some of the features of Microsoft 

PowerPoint. You probably have your own vision for an Open House presentation. It is now time 

to make a connection between what you want to say and what Microsoft PowerPoint can do. 

 

Reflect on your upcoming presentation by completing the following phrases. 

 

1. I would like my presentation to say the following things about me as an educator… 

  

 

 

2. I would like my presentation to say the following things about my teaching practice… 

  

 

 

3. I would like my presentation to say the following things about my classroom… 

  

 

 

4. After seeing my presentation, I would like the audience to know… 

  

 

 

  

The intent of creating this presentation is to highlight the key features of PowerPoint including 

how to enter, arrange, and edit information; format slide appearance; select various layouts; 

insert objects, and apply special effects. Once these skills are learned, you can apply them to 

expand this presentation to suit your needs and situation. 
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Organize Your Ideas 

Use the storyboard below to outline the content for each slide in your presentation. 

 

Slide 1  Slide 2 

   

Welcome Slide 
name of the school, teacher, grade, or course 

 All About Me Slide 
list information such as years of experience, 

specialties, credentials, hobbies, and interests 

   

   

Slide 3  Slide 4 

   

School Events or Trips Slide 
list school events or field trips 

 
Curriculum Slide 

outline long-range plans such as the content of 

each term, subjects, topics of study 

   

   

Slide 5  Slide 6 

   

Extracurricular Slide 
list extracurricular activities, sports teams, or clubs 

 Contact Information Slide 
list teacher name, school name, school phone 

number, and school website 

 

 

If the focus of an open house to parents is not suitable to your situation, consider modifying 

the content of the presentation. Some other suggestions are: 
 

 overview for students to be shown on the first day of class 

 assignment summary that describes required content, due date, and assessment 

 information about the computer lab including hardware, software, and rules 

 information about the library including resources, sign out procedures, and hours 

 explanation of a concept in the curriculum 
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Make the Connection: Customize the Content of your Presentation 
 

Depending on their role in the school, educators have different 

purposes for hosting an Open House. Homeroom teachers, 

librarians, special education teachers, administrators, and other 

school staff all play a part in the Open House process, but may 

need to communicate different content. 

 

Below are a number of suggestions for the content that various 

school staff might include in their multimedia presentations for 

an Open House. 

 

Teacher’s List 

 

Topic Information 

About the Teacher 
 credentials, experience in education 

 specialties, additional qualifications 

 educational philosophy 

 goals for the year 

 favorite quotes pertaining to education 

 

Classroom Happenings 
 video footage of classroom activities 

 rules 

 list of texts used in class 

 physical activity plan 

 special projects 

 samples of student work (scanned) 

 allergy/health concerns and procedures 

 available special education services 

 second language support 

 

School and Home 

Connections 
 list of school supplies required 

 recommended books for students  

 solicit volunteers for classroom 

 homework tips 

 useful websites to consult for homework help and research 

 frequently asked questions and answers 

 

Contact Information 
 teacher’s email address 

 school phone number 
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Administrator’s List 

 

Topic Information 

About the Administration 
 credentials and experience in education 

 specialties, additional qualifications 

 educational philosophy 

 school philosophy 

 

About the School 
 school philosophy 

 hours of operation 

 daily schedule 

 demographic data 

 standardized testing results 

 discipline policy 

 sign in and sign out procedures 

 

About the Staff 
 staff photo with names of teachers and grades taught 

 contact list for teachers, custodians, and office staff 

 contact list for trustee, school board, and superintendent 

 

School Programs 
 extra-curricular programs 

 fundraising 

 school events 

 description of programs such as art or music 

 description of specialty rooms such as computer lab 

 description of resource rooms such as library 

 before and after school child care 

 

Feedback and 

Involvement 
 school council 

 volunteering 

 parent conferences 

 questions and answers 
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